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Chapter 1

Overview

Introduction
Xilinx open asymmetric multi-processing (OpenAMP) is a framework providing the software 
components needed to enable the development of software applications for asymmetric 
multi-processing (AMP) systems. The OpenAMP framework provides the following for both 
Zynq® UltraScale+™ MPSoC and Zynq-7000 All Programmable (AP) SoC devices:

• The remoteproc, RPMsg, and virtIO components that are used for a Linux master or 
a bare-metal remote configuration.

• Proxy infrastructure and demos that showcase the ability of a proxy on a master 
processor running Linux on the ARM processor unit (APU) to handle printf, scanf, 
open, close, read, and write calls from a bare-metal OS-based remote contexts 
running on the remote processor unit (RPU).

Some of the advantages provided by the OpenAMP Framework for Zynq-7000 AP Soc and 
Zynq UltraScale+ MPSoC devices are, as follows:

• Process overviews for using the OpenAMP Framework components, with descriptions 
of all included functions.

• Sample implementations of using AMP across a heterogeneous system with RPMsg.

• Bare-metal and Linux examples to bootstrap development. Step-by-step procedures for 
building bare-metal and FreeRTOS applications are provided, as well as pointers to 
further explanatory information in the code base.

• Demonstration of using RPMsg communication channel implementation for a 
multiprocessor system-on-chip such as the Zynq UltraScale+ MPSoC device.

• FreeRTOS support for Cortex™-A9 and Cortex-R5 slaves.

• Examples and applications distributed in the Xilinx® Software Development Kit (SDK), 
with templates to use for echo-tests, matrix multiplications, and RPC.
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Chapter 1: Overview
Software Requirements
The requirement of the current versions of PetaLinux and SDK requirements must be met. 

° PetaLinux must be installed.

° SDK might need to be installed if you want to rebuild the remote processor 
firmware.

Prerequisites
To use the OpenAMP Framework effectively, you must have a basic understanding of: 

• Linux, PetaLinux, and Xilinx SDK

• How to boot a Xilinx board using JTAG boot

• The remoteproc, RPMsg, and virtIO components used in Linux and bare-metal

Components in OpenAMP
OpenAMP framework uses the following key components:

• virtIO: the virtIO is a virtualization standard for network and disk device drivers 
where only the driver on the guest device is aware it is running in a virtual 
environment, and cooperates with the hypervisor. This concept is used by RPMsg and 
remoteproc for a processor to communicate to the remote.

• remoteproc: This API controls the life cycle management (LCM) of the remote 
processors. The remoteproc API that OpenAMP uses is compliant with the 
infrastructure present in the Linux Kernel 3.18 and later. The remoteproc uses 
information published through the remote processor firmware resource table to 
allocate system resources and to create virtIO devices.

• RPMsg: This API allows inter-process communications (IPC) between software running 
on independent cores in an AMP system. This is also compliant with the RPMsg bus 
infrastructure present in the Linux Kernel version 3.18 and later.

The main Linux Kernel allows the following: 

• Linux applications running on the master processor to control the LCM of a remote 
processor

• IPC between the master and remotes

The main Linux Kernel does not include source code required to support other platforms 
running on the remote processor (such as bare-metal or FreeRTOS applications) to 
communicate with a Linux master. 
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Chapter 1: Overview
The OpenAMP framework provides this missing functionality by providing the infrastructure 
required for FreeRTOS and bare-metal environments to communicate with the Linux Kernel 
in AMP systems. This is possible because the OpenAMP framework builds upon the 
remoteproc, RPMsg, and virtIO functions included in the Linux Kernel.

Process Overview
It is common for the master processor in an AMP system to bring up software on the remote 
cores on a demand-driven basis. These cores then communicate using inter process 
communication (IPC). This allows the master processor to off-load work to the other 
processors, called remote processors. Such activities are coordinated and managed by the 
Xilinx OpenAMP software which builds upon pre-established capabilities within Linux: such 
as the RPMsg, remoteproc, and virtIO functions.

The general OpenAMP flow is as follows:

1. The Linux master configures the remote processor and shared memory is created.

2. The master boots the remote processor. 

3. The remote processor calls remoteproc_resource_init(), which creates and 
initializes the virtIO resources and the RPMsg channels for the master.

4. The master receives these channels and invokes the callback channel that was created.

5. The master responds to the remote context, acknowledging the remote processor and 
application. 

6. The remote invokes the RPMsg channel that was registered. The RPMsg channel is now 
established, and both sides can use the RPMsg calls to communicate.

To shut down the remote processor:

1. The master application sends an application-specific shutdown message to the remote 
application.

2. The remote application cleans up its resources and sends an acknowledgment to the 
master.

3. The remote calls the remoteproc_resource_deinit() function to free the 
remoteproc resources on the remote side.

4. The master shuts down the remote processor and frees the remoteproc on its side. 
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Chapter 1: Overview
The following figure shows the process interactions.

For more information, see the specific function descriptions in Chapter 5, Remoteproc 
Development and Chapter 6, RPMsg Development.

Quick Try
Use the following basic steps to boot Linux and run an openamp application using pre-built 
images. The following steps apply to the ZCU102 board.

The echo-test application sends packets from Linux running on quad-core Cortex-A53 to a 
single Cortex-R5 running FreeRTOS, which sends them back.

1. Extract files BOOT.BIN, image.ub, and openamp.dtb files from a pre-built PetaLinux 
BSP tarball to an SD card.

host shell$ tar xvf xilinx-zcu102-v2017.1-final.bsp --strip-components=4 --wildcards 
*/BOOT.BIN */image.ub */openamp.dtb
host shell$ cp BOO.BIN image.ub openamp.dtb <your sd card>

Note: Alternatively, if you already created a PetaLinux project with a provided BSP for your 
board, you can find pre-built images in the <your project>/pre-built/linux/images/ 
directory.

X-Ref Target - Figure 1-1

Figure 1-1: System Sequence Diagram
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Chapter 1: Overview
2. Go to u-boot prompt and boot Linux from the SD card:

...
Hit any key to stop autoboot:  0 
ZynqMP> mmcinfo && fatload mmc 0 ${netstart} ${kernel_img} &&  fatload mmc 0 
0x14000000 openamp.dtb
Device: sdhci@ff170000
...
reading image.ub
31514140 bytes read in 2063 ms (14.6 MiB/s)
reading openamp.dtb
38320 bytes read in 18 ms (2 MiB/s)
ZynqMP> bootm $netstart $netstart 0x14000000
...

Note: As an alternative to all steps above to SD boot, you can JTAG boot the board. For this you 
need to have connected a JTAG cable, installed JTAG drivers, and created a PetaLinux project 
using a provided BSP.
To do this, you must go in the <your project>/pre-built/linux/images directory 
and replace the system.dtb file by openamp.dtb, then type petalinux-boot --jtag 
--prebuilt 3.

3. At the Linux login prompt, type root for user and root for password, and then run the 
echo-test demo.

plnx_aarch64 login: root
Password: 
root@plnx_aarch64:~# echo image_echo_test > 
/sys/class/remoteproc/remoteproc0/firmware 
root@plnx_aarch64:~# echo start > /sys/class/remoteproc/remoteproc0/state   
[  177.375451] remoteproc remoteproc0: powering up ff9a0100.zynqmp_r5_rproc
[  177.384705] remoteproc remoteproc0: Booting fw image image_echo_test, size 644144
[  177.396832] remoteproc remoteproc0: registered virtio0 (type 7)
[  177.399108] virtio_rpmsg_bus virtio0: rpmsg host is online
[  177.412370] zynqmp_r5_remoteproc ff9a0100.zynqmp_r5_rproc: RPU boot from TCM.
[  17Starting application...
Try to init remoteproc resource
Init remoteproc resource succeeded
Waiting for events...
7.422089] remoteproc remoteproc0: remote processor ff9a0100.zynqmp_r5_rproc is now 
up
[  177.442121] virtio_rpmsg_bus virtio0: creating channel rpmsg-openamp-demo-channel 
addr 0x1
root@plnx_aarch64:~# modprobe rpmsg_user_dev_driver
[  188.089835] rpmsg_user_dev_driver virtio0:rpmsg-openamp-demo-channel: 
rpmsg_user_dev_rpmsg_drv_probe
[  188.101250] rpmsg_user_dev_driver virtio0:rpmsg-openamp-demo-channel: new 
channel: 0x400 -> 0x1!
root@plnx_aarch64:~# echo_test
 Echo test start 
 Open rpmsg dev! 
[  190.364739] rpmsg_user_dev_driver virtio0:rpmsg-openamp-demo-channel: Sent 
init_msg to target 0x1.
 **************************************** 
 Please enter command and press enter key
 **************************************** 
 1 - Send data to remote core, retrieve the echo and validate its integrity .. 
 2 - Quit this application .. 
 CMD>
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Chapter 1: Overview
Known Limitations
The following are the known limitations in OpenAMP:

• Running OpenAMP demo for Zynq devices with QEMU is not supported.

Only OpenAMP demos for ZynqMP devices are supported with QEMU.

Known Issues
• When trying to load an invalid image with remoteproc, you might not be able to load 

any subsequent image. 

If this happens, you will need to reboot Linux. To avoid this issue, make sure your image 
addresses in linker script match the DTS, and the rproc mem in the resource table 
address does not overlap.

A patch is provided in the Xilinx OpenAMP wiki [Ref 1] to fix this problem. In this case 
you will see the following error:

failed to declare rproc mem as DMA mem

System Design Considerations
With ZynqMP, PetaLinux default BSP does not define specific subsystems, as isolation 
configuration is disabled. All devices are shown in the device tree (DTS) and Linux owns 
everything. 

By default, power management (PM) is enabled in the Linux kernel configuration, and thus 
Linux can suspend its devices.

When RPU is used and needs to access some device, you must do one of the following:

• Use isolation configuration in Vivado to setup subsystems.

Note: This doesn't cover programmable logic (PL) devices; for those used by RPU you still need 
to disable them manually in the DTS.

• Manually disable devices owned by the RPU in the DTS.
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Chapter 2

Building Linux Applications and Remote 
Firmware

Introduction 
The Xilinx® software development kit (SDK) contains templates to aid in the development 
of OpenAMP Linux master applications, and bare-metal/FreeRTOS remote applications.

The following sections describe how to create OpenAMP applications with SDK and 
PetaLinux tools. 

• Use SDK to create the bare-metal or FreeRTOS remote applications.

• Use PetaLinux tools to create Linux user applications and Kernel user modules, build 
the Linux kernel, generate the device tree, and generate the rootfs.

The source code is available at
https://github.com/Xilinx/meta-openamp/tree/rel-v2017.1

For example:

• Echo Test Linux application: https://github.com/Xilinx/meta-openamp/
blob/rel-v2017.1/recipes-openamp/rpmsg-examples/rpmsg-echo-test/echo_test.c

• RPMsg module: https://github.com/Xilinx/meta-openamp/blob/
rel-v2017.1/recipes-kernel/rpmsg-user-module/files/rpmsg_user_dev_driver.c

Note: You can use the demo Linux applications already included in the PetaLinux BSP as pre-built 
binaries. You can otherwise build your own Linux applications with SDK. See the Xilinx Software 
Developer Kit Help (UG782) for more information [Ref 3].
Xilinx OpenAMP Framework 11
UG1186 (v2017.1) May 3, 2017 www.xilinx.com

Send Feedback
UG1186 (v2017.2) June 29, 2017

https://www.xilinx.com
https://github.com/Xilinx/meta-openamp/blob/rel-v2017.2/recipes-openamp/rpmsg-examples/rpmsg-echo-test/echo_test.c
https://github.com/Xilinx/meta-openamp/blob/rel-v2017.2/recipes-openamp/rpmsg-examples/rpmsg-echo-test/echo_test.c
https://github.com/Xilinx/meta-openamp/blob/rel-v2017.2/recipes-kernel/rpmsg-user-module/files/rpmsg_user_dev_driver.c
https://github.com/Xilinx/meta-openamp/blob/rel-v2017.2/recipes-kernel/rpmsg-user-module/files/rpmsg_user_dev_driver.c
https://github.com/Xilinx/meta-openamp/tree/rel-v2017.2
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1186&Title=OpenAMP%20Framework%20for%20Zynq%20Devices%3A%20Getting%20Started%20Guide&releaseVersion=2017.2&docPage=11


Chapter 2: Building Linux Applications and Remote Firmware
Echo Test in Linux Master and Bare-Metal or 
FreeRTOS Remotes
This test application sends a number of payloads from the master to the remote and tests 
the integrity of the transmitted data.

• The echo test application uses the Linux master to boot the remote bare-metal 
firmware using remoteproc . 

• The Linux master then transmits payloads to the remote firmware using RPMsg. The 
remote firmware echoes back the received data using RPMsg. 

• The Linux master verifies and prints the payload. 

Matrix Multiplication for Linux Master and 
Bare-Metal or FreeRTOS Remotes
The matrix multiplication application provides a more complex test that generates two 
matrices on the master. These matrices are then sent to the remote, which is used to 
multiply the matrices. The remote then sends the result back to the master, which displays 
the result.

The Linux master boots the bare-metal remote firmware using remoteproc. It then 
transmits two randomly-generated matrices using RPMsg. 

The bare-metal firmware multiplies the two matrices and transmits the result back to the 
master using RPMsg.

Proxy Application for Linux Masters and 
Bare-Metal or FreeRTOS Remotes
This application creates a proxy between the Linux master and the remote core, which 
allows the remote firmware to use console and execute file I/O on the master.

The Linux master boots the firmware using the proxy_app. The remote firmware executes 
file I/O on the Linux file system (FS), which is on the master processor. The remote firmware 
also uses the master console to receive input and display output.
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Chapter 2: Building Linux Applications and Remote Firmware
Building Remote Applications in SDK
You can build remote applications using SDK by using the following procedures. The 
PetaLinux BSP already include pre-built firmware for a remote processor (Zynq® 
Cortex™-A9 #1 and Zynq UltraScale+™ MPSoC Cortex-R5 #0);The following steps are 
necessary only if you plan to re-build the demo applications running on the remote 
processor.

Creating an Application Project for OpenAMP
1. From the SDK window, create the application project by selecting File > New > 

Application Projects.

a. Specify the BSP OS platform:

- standalone for a bare-metal application.

- freertos<version>_xilinx for a FreeRTOS application.

b. Specify the hardware platform.

c. Select the processor: 

For the Zynq UltraScale+ MPSoC device (ZynqMP), Cortex-R5 (RPU) is supported.

- Select psu_cortexr5_0 or psu_cortexr5_1.

IMPORTANT:  If you select psu_cortexr5_1, you must update memory addresses and interrupts. See 
Application Resource Table and Linker Script Files in Appendix A.

- For the Zynq-7000 All Programmable (AP) SoC device (zynq), only Cortex-A9 is 
supported. 

Select ps7_cortexa9_1.

d. Select one of the following:

- Use Existing if you had previously created an application with a BSP and want 
to re-use the same BSP.

- Create New BSP to create a new BSP.

IMPORTANT: If you select Create New BSP, the openamp library is automatically included, but the 
compiler flags must be set as indicated in the upcoming steps.

e. Click Next to select an available template (do not click Finish).
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Chapter 2: Building Linux Applications and Remote Firmware
2. Select one of the three application templates available for OpenAMP remote bare-metal 
from the available templates:

° OpenAMP echo-test

° OpenAMP matrix multiplication Demo

° OpenAMP RPC Demo

3. Click Finish.

4. In the SDK project explorer, right-click the BSP and select Board Support Package 
Settings.

5. Navigate to the BSP Settings > Overview > OpenAMP. 

6. Set the WITH_PROXY parameter as follows: 

° For the OpenAMP RPC demonstration, set the parameter to true (default).

° For other demo applications, set the parameter to false.

Note: Having WITH_PROXY=true is needed for OpenAMP to redirect _open(), _close(), 
_read(), and _write() to the master processor and instruct the makefile to compile extra 
code that is not needed or desired for other applications.

7. Navigate to the BSP settings drivers: Settings > Overview > Drivers > 
<selected_processor>.

For the Zynq-7000 All Programmable (AP) SoC device (zynq) only: 

° To disable initialization of shared resources when the master processor is handling 
shared resources initialization, add:

-DUSE_AMP=1

In the following examples, ps7_cortexa9_0 runs Linux while the OpenAMP slave 
runs on ps7_cortexa9_1, therefore you need to set this parameter. 

8. Add any necessary parameters to the extra_compiler_flags.

9. Click the OK button. 
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Chapter 2: Building Linux Applications and Remote Firmware
OpenAMP SDK Key Source Files
The following key source files are available in the Xilinx SDK application 

• Platform Info (platform_info.c/.h): These files contain hard-coded, 
platform-specific values used to get necessary information for OpenAMP. 

° #define VRING1_IPI_INTR_VECT or IPI_IRQ_VECT_ID: This is the 
inter-processor interrupt (IPI) vector for the remote processor.

° #define IPI_BASE_ADDR: The IPI base address for the remote processor.

° #define RPMSG_CHAN_NAME: The name used to identify a communication channel 
between two processors.

• Resource Table (rsc_table.c/.h): The resource table contains entries that specify 
the memory and virtIO device resources. The virtIO device contains device 
features, vring addresses, size, and alignment information. The resource table entries 
are specified in rsc_table.c and the remote_resource_table structure is 
specified in rsc_table.h.

For the RSC_RPROC_MEM resource, the Linux kernel remoteproc allocates shared 
memory for vrings and RPMsg buffers from the memory specified in this resource. If you 
do not specify this resource in the resource table, the Linux side will allocate the 
memory from its system memory. If you specify it in the resource table, it must be inside 
the range defined by the DTS reserved-memory section for rproc. It should not overlap 
its address with the memory nodes in the device tree which are used to load the 
firmware. 

• Helper (helper.c/.h): They contain platform-specific APIs that allow the remote 
application to communicate with the hardware. They include functions to initialize and 
control the GIC.
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Chapter 3

Building and Running a Linux Project with 
Applications

Introduction
This chapter describes how to perform the following: 

• Setting up PetaLinux with OpenAMP

• Settings for the Device Tree Binary Source

• Building the Applications and the Linux Project

• Booting the PetaLinux Project

• Running the Example Application

Setting up PetaLinux with OpenAMP
PetaLinux requires the following preparation before use:

1. Create the PetaLinux master project in a suitable directory without any spaces. In this 
guide it is named <plnx_proj>: 

petalinux-create -t project -s <PATH_TO_PETALINUX_ZYNQMP_PROJECT_BSP>

2. Navigate to the <plnx_proj> directory:

cd <plnx_proj>
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Chapter 3: Building and Running a Linux Project with Applications
3. Include a remote application in the PetaLinux project.

This step is needed if you are not using one of the pre-built remote firmware already 
included with the PetaLinux BSP. After you have developed and built a remote 
application (for example, with SDK) it must be included in the PetaLinux project so that 
it is available from the Linux filesystem for remoteproc.

a. Create a PetaLinux application inside the components/apps/<app_name> 
directory, using the following command:

petalinux-create -t apps --template install -n <app_name> --enable

b. Copy the firmware (that is, the .elf file) built with SDK for the remote processor 
into this directory:

project-spec/meta-user/recipes-apps/<app_name>/files/

c. Modify the project-spec/meta-user/recipes-apps/<app_name>/
<app_name>.bb to install the remote processor firmware in the RootFS. 

For example:

SUMMARY = "Simple test application"
SECTION = "PETALINUX/apps"
LICENSE = "MIT"
LIC_FILES_CHKSUM = 
"file://${COMMON_LICENSE_DIR}/MIT;md5=0835ade698e0bcf8506ecda2f7b4f302"

SRC_URI = "file://<myfirmware>"   
S = "${WORKDIR}"
INSANE_SKIP_${PN} = "arch"

do_install() {
             install -d ${D}/lib/firmware
             install -m 0644 ${S}/<myfirmware> ${D}/lib/firmware/<myfirmware>
}

FILES_${PN} = "/lib/firmware/<myfirmware>"

4. For the Zynq®-7000 AP SoC (zynq) device only, do step a and step b: 

a. Set the kernel base address. Because bare-metal and RTOS boot support is from 
address 0; consequently, you must set the location for Linux to a higher address: 

- Run petalinux-config, and set the kernel base address to 0x10000000, as 
follows: 

Subsystem AUTO Hardware Settings --->
Memory Settings --->
(0x10000000) kernel base address
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Chapter 3: Building and Running a Linux Project with Applications
b. If you have configured using PetaLinux U-Boot autoconfig, set the memory 
address into which the U-Boot loads the Kernel. 

- Run petalinux-config:

u-boot Configuration --->
(0x11000000) netboot offset

5. For all devices, configure the kernel options to work with OpenAMP:

a. Start the PetaLinux Kernel configuration tool:

petalinux-config -c kernel

b. Enable loadable module support:

[*] Enable loadable module support --->

c. Enable user space firmware loading support:

Device Drivers --->
Generic Driver Options --->

<*> Userspace firmware loading support

d. Enable the remoteproc driver support: Note that the commands differ, based on 
which Zynq device you are using:

Device Drivers --->
Remoteproc drivers --->

# for R5: 
<M> ZynqMP_r5 remoteproc support
# for Zynq A9
<M> Support ZYNQ remoteproc 

e. For the Zynq-7000 All Programmable (AP) SoC (Zynq) only, set memory split to 
2G/2G (or use 1G/3G user/kernel):

Kernel Features--->
Memory split (...)--->
(x) 2G/2G user/kernel split

f. For Zynq-7000 All Programmable (AP) SoC (Zynq) only, enable High Memory 
support:

Kernel Features--->
[*] High Memory Support--->
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Chapter 3: Building and Running a Linux Project with Applications
6. Enable all of the modules and applications in the RootFS:

IMPORTANT: These options are only available in the PetaLinux reference BSP. The applications in this 
procedure are examples you can use.

a. Open the RootFS configuration menu:

petalinux-config -c rootfs

b. Ensure the OpenAMP applications and rpmsg modules are enabled:

Filesystem Packages ---> 
misc ---> 
packagegroup-petalinux-openamp ---> 
[*] packagegroup-petalinux-openamp

Note: packagegroup-petalinux-openamp enables many openamp related 
sub-components. If you need more fine-grained control, do not set this packagegroup. 
Instead, enable the following individual components as needed:

rpmsg-echo-test, rpmsg-mat-mul, rpmsg-proxy-app, rpmsg-proxy-module, 
rpmsg-user-module

c. If needed, enable inclusion of default remote processor firmware images:

Filesystem Packages --->
misc --->
openamp-fw-echo-testd --->
[*] openamp-fw-echo-testd

openamp-fw-mat-muld --->
[*] openamp-fw-mat-muld

openamp-fw-rpc-demo --->
[*] openamp-fw-rpc-demo

Note: This includes the same remote processor firmwares provided by pre-built images as 
found in the rootfs /lib/firmware directory. It is not needed if you build new images with 
the SDK.

Settings for the Device Tree Binary Source 
The PetaLinux reference BSP includes a Device Tree Binary (DTB) for OpenAMP located at:

pre-built/linux/images/openamp.dtb

The device tree setting for the shared memory and the kernel remoteproc is 
demonstrated in:

project-spec/meta-user/recipes-bsp/device-tree/files/openamp-overlay.dtsi

The openamp.dtb and openamp-overlay.dtsi files are provided for reference only. 
You need to edit the system-user.dts file to include the content from 
openamp-overlay.dtsi for your project.
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Chapter 3: Building and Running a Linux Project with Applications
The overlay contains nodes that OpenAMP requires in the device tree.

• For ZynqMP running Linux on Cortex™-A53 and communicating with Cortex-R5:

/ {
reserved-memory {
#address-cells = <2>;
#size-cells = <2>;
ranges;

/* Reserved DDR memory for RPU firmware and shared memory between APU and RPU */
rproc_0_reserved: rproc@3ed000000 {
no-map;
reg = <0x0 0x3ed00000 0x0 0x1000000>;

};  
};  

power-domains {
pd_r5_0: pd_r5_0 {
#power-domain-cells = <0x0>;
pd-id = <0x7>;

};  
pd_tcm_0_a: pd_tcm_0_a {
#power-domain-cells = <0x0>;
pd-id = <0xf>;

};  
pd_tcm_0_b: pd_tcm_0_b {
#power-domain-cells = <0x0>;
pd-id = <0x10>;

};  
};  

amba {
r5_0_tcm_a: tcm@ffe00000 {
compatible = "mmio-sram";
reg = <0x0 0xFFE00000 0x0 0x10000>;
pd-handle = <&pd_tcm_0_a>;

};  
r5_0_tcm_b: tcm@ffe20000 {
compatible = "mmio-sram";
reg = <0x0 0xFFE20000 0x0 0x10000>;
pd-handle = <&pd_tcm_0_b>;

};  

elf_ddr_0: ddr@3ed00000 {
compatible = "mmio-sram";
reg = <0x0 0x3ed00000 0x0 0x40000>;

};  

test_r50: zynqmp_r5_rproc@0 {
compatible = "xlnx,zynqmp-r5-remoteproc-1.0";
reg = <0x0 0xff9a0100 0x0 0x100>, <0x0 0xff340000 0x0 0x100>, <0x0 0xff9a0000 0x0 0x100>;
reg-names = "rpu_base", "ipi", "rpu_glbl_base";
dma-ranges;
core_conf = "split0";
sram_0 = <&r5_0_tcm_a>;
sram_1 = <&r5_0_tcm_b>;
sram_2 = <&elf_ddr_0>;
pd-handle = <&pd_r5_0>;
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Chapter 3: Building and Running a Linux Project with Applications
interrupt-parent = <&gic>;
interrupts = <0 29 4>;

} ; 
};  

};

In the above device tree demo, the OpenAMP in APU uses the PL0 IPI instead of the 
default APU IPI for inter-processor notification because the default APU IPI has been 
dedicated to the communication with PMU FW.

For ZynqMP, you can configure how the Cortex-R5 is operating by setting the 
core_conf parameter. The current settings works with the demo applications 
referenced in this document. Appendix A, Configuration Parameters gives a more 
detailed explanation of those parameters.

• For Zynq_A9:

/ {
amba {
elf_ddr_0: ddr@0 {
compatible = "mmio-sram";
reg = <0x100000 0x100000>;

};  

};  

remoteproc0: remoteproc@0 {
compatible = "xlnx,zynq_remoteproc";
firmware = "firmware";
vring0 = <15>;
vring1 = <14>;
sram_0 = <&elf_ddr_0>;

};  
};

Building the Applications and the Linux Project
To build the applications and Linux project, do the following:

1. Ensure that you are in the PetaLinux project root directory:

cd <plnx_proj>

2. Build PetaLinux: petalinux-build

TIP: If you encounter any issues append -v to petalinux-build to see the respective textual output.

If the build is successful, the images are in the images/linux folder: 
<plnx_proj>/images/linux 
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Booting the PetaLinux Project
You can boot the PetaLinux project from QEMU or hardware.

Booting on QEMU
After a successful build, you can run the PetaLinux project on QEMU as follows.

1. Navigate to the PetaLinux directory: cd <plnx_proj>

2. Run PetaLinux boot: petalinux-boot --qemu --kernel

Booting on Hardware
After a successful build, you can run the PetaLinux project on hardware. Follow these 
procedures to boot OpenAMP on a board.

Setting Up the Board

1. Connect the board to your computer, and ensure that it is powered on.

2. If the board is connected to a remote system, start the hw_server on the remote 
system.

3. Open a console terminal and connect it to UART on the board.

Downloading the Images

1. Navigate to the PetaLinux directory:

cd <plnx_proj>

2. Run the PetaLinux boot:

° Using a remote system:

petalinux-boot --jtag --kernel --hw_server-url <remote_system>

° Using a local system:

petalinux-boot --jtag --kernel

TIP: If you encounter any issues append -v to the above commands to see the textual output.
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Running the Example Applications
After the system is up and running, log in with the username and password root. After 
logging in, the following example applications are available:

• Running the Echo Test

• Running the Matrix Multiplication Test

• Running the Proxy Application

Note: Some important things to note are:

° After booting the Linux Kernel the remoteproc driver is already loaded. If not, check 
it has been enabled in the kernel config and check your device tree.

° If you have unloaded the remoteproc driver, you can load it as follows:

- For the Zynq UltraScale+ MPSoC device: 

modprobe zynqmp_r5_remoteproc

- For the Zynq 7000 All Programmable (AP) SoC device: 

modprobe zynq_remoteproc

Running the Echo Test
1. Load the Echo test firmware and RPMsg module:

echo image_echo_test > /sys/class/remoteproc/remoteproc0/firmware
echo start > /sys/class/remoteproc/remoteproc0/state
modprobe rpmsg_user_dev_driver

2. Run the test:

echo_test

The test starts.

3. Follow the on-screen instructions to complete the test.

4. After you have completed the test, unload the application:

modprobe -r rpmsg_user_dev_driver
echo stop > /sys/class/remoteproc/remoteproc0/state

If you want to simply reload and run the RPU firmware, you can keep 
rpmsg_user_dev_driver LKM loaded and simply re-issue a start.
Xilinx OpenAMP Framework 23
UG1186 (v2017.1) May 3, 2017 www.xilinx.com

Send Feedback
UG1186 (v2017.2) June 29, 2017

https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1186&Title=OpenAMP%20Framework%20for%20Zynq%20Devices%3A%20Getting%20Started%20Guide&releaseVersion=2017.2&docPage=23


Chapter 3: Building and Running a Linux Project with Applications
Running the Matrix Multiplication Test
1. Load the Matrix Multiply firmware and RPMsg module:

echo image_matrix_multiply > /sys/class/remoteproc/remoteproc0/firmware
echo start > /sys/class/remoteproc/remoteproc0/state
modprobe rpmsg_user_dev_driver

2. Run the test: 

mat_mul_demo

The test starts. 

3. Follow the on screen instructions to complete the test.

4. After you have completed the test, unload the application:

modprobe -r rpmsg_user_dev_driver
echo stop > /sys/class/remoteproc/remoteproc0/state

Running the Proxy Application
1. Load and run the proxy application in one step. The proxy application automatically 

loads the required modules:

proxy_app

2. When the application prompts you to Enter name, enter any string.

3. When the application prompts you to Enter age, enter any integer.

4. When the application prompts you to Enter value for pi, enter any floating point number. 

5. The application then prompts you to re-run the test.

6. After you exit the application, the module unloads automatically.
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Chapter 4

Linux Userspace RPMsg

Linux Userspace RPMsg Overview
The OpenAMP library depends on the libmetal library. With the use of the libmetal 
library, OpenAMP is able to access the interprocess communication interface (IPI) device 
and shared memory from the Linux userspace and, therefore, OpenAMP can enable RPMsg 
in the Linux userspace.

For more information about the libmetal library, see Appendix B, Libmetal Introduction 
and Libmetal Examples.

To try RPMsg in Linux userspace, follow the example in this chapter. 

Linux Userspace RPMsg Example
Note: This RPMsg in Linux userspace example only supports Zynq® UltraScale+™ MPSoC devices.

You can boot RPU independently with the RPMsg in Linux userspace implementation.

The following sections provide the steps to build the RPMsg Linux userspace applications.
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Building Remote Applications
You can use the OpenAMP RPU applications you created in Building Remote Applications 
after modifying them slightly.

Edit the rsc_table.c file and modify the RSC_VDEV entry in the resources structure, to 
look as follows:

{
  RSC_VDEV, VIRTIO_ID_RPMSG_, 0, RPMSG_IPU_C0_FEATURES, 0, 0, 
VIRTIO_CONFIG_STATUS_DRIVER_OK, 
}

In this example, you replaced 0 with VIRTIO_CONFIG_STATUS_DRIVER_OK. Without this 
change, the RPU firmware will not finish remoteproc/rpmsg initialization until this status bit 
is set, which indicates that the RPMsg driver is ready.

Build Linux Userspace RPMsg Demo Application 
Using PetaLinux Tools
Before using PetaLinux tools, follow these preparatory steps:

1. Create the PetaLinux master project in a suitable directory without any spaces. In this 
guide it is named <plnx_proj>: 

$ petalinux-create -t project -s <PATH_TO_PETALINUX_ZYNQMP_PROJECT_BSP>

2. Navigate to the directory: 

$ cd <plnx_proj>

3. Start the rootfs configuration utility:

$ petalinux-config -c rootfs

4. Enable the required rootfs packages for this demo:

Filesystem Packages ---> 
    misc ---> 
        packagegroup-petalinux-openamp ---> 
            [*] packagegroup-petalinux-openamp

Note: packagegroup-petalinux-openamp enables many openamp related sub-components. If 
you want to enable only the components needed here, do not set this packagegroup. Instead, 
enable the following individual components:
open-amp, open-amp-demos, libmetal, (libsysfs).

5. Setting Device Tree for the Linux Userspace RPMsg Application Demo
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Chapter 4: Linux Userspace RPMsg
The libmetal Linux demo uses Userspace I/O (UIO) devices for IPI and shared memory. 
Copy the following to project-spec/meta-user/recipes-bsp/device-tree/
files/system-user.dts in the PetaLinux project and modify as needed.

/ {
reserved-memory {
#address-cells = <2>;
#size-cells = <2>;
ranges;
/* Reserved DDR memory for RPU firmware and shared memory between APU and RPU */
rproc_0_reserved: rproc@3ed000000 {
no-map;
reg = <0x0 0x3ed00000 0x0 0x1000000>;

};
};
amba {

/* UIO device node for vring device memory */
vring: vring@0 {

compatible = "vring_uio";
reg = <0x0 0x3ed40000 0x0 0x40000>;

};
/* UIO device node for shared memory device memory */

shm0: shm@0 {
compatible = "shm_uio";
reg = <0x0 0x3ed80000 0x0 0x80000>;

};
/* UIO device node for IPI device */

ipi0: ipi@0 {
compatible = "ipi_uio";
reg = <0x0 0xff340000 0x0 0x1000>;
interrupt-parent = <&gic>;
interrupts = <0 29 4>;

};
};

};

Note: As the default APU IPI has been dedicated to PMU FW communication, OpenAMP picked 
another IPI (PL0 IPI) for communication notification.

You can find the source code of the Linux userspace RPMsg applications demos in the 
following locations:

• For the common code across the three applications:

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/platf
orm_info.c

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/platf
orm_info.h

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/rsc_t
able.c

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/rsc_t
able.h
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• Application specific code:

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/rsc_t
able.h

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/matrix_multiply/matrix
_multiply.c

° https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/rpc_demo/rpc_demod.
c

For more information on how to write an RPMsg Linux userspace application, see 
Appendix C, Linux Userspace RPMsg Application Flow.

Build the Linux Demo Application and the Linux 
Project
1. Go to the PetaLinux project:

$ cd <plnx_proj>

2. Build the PetaLinux project:

$ petalinux-build

The kernel images and the device tree binary are located in the 
<plnx_proj>/images/linux directory.

Testing on Hardware
1. Go to your PetaLinux project:

$ cd <plnx_proj>

2. Build the PetaLinux project:

$ petalinux-build

3. Run PetaLinux boot:

$ petalinux-boot --jtag --kernel

If you encounter any issues, append -v to these commands to see the textual output.
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4. Boot the RPU firmware built with Xilinx® SDK with xsdb command:

$ xsdb
xsdb% connect
xsdb% ta 7 # this is the RPU0 target.
    # you can use "ta" to see all the targets and which you have connected to
    # in which case you will see that RPU0 is ‘Halted.’
xsdb% rst -processor # reset the connected RPU target
    # if you type “ta” you will see that RPU0 is ‘Suspended.’
xsdb% dow <the RPU OpenAMP demo ELF image built with Xilinx SDK>
xsdb% con # This starts the RPU

You can also use other methods to boot Linux on APU and the firmware on RPU, such as 
SD boot. This example only documents a JTAG boot.

5. On the APU Linux target console, run the demo applications echo_test-openamp, 
mat_mul_demo-openamp, and proxy_app-openamp. This process produces output 
similar to the following:

# echo_test-openamp
metal: warning:   skipped page size 2097152 - invalid args
metal: info:      metal_uio_dev_open: No IRQ for device 3ed40000.vring.
metal: info:      metal_uio_dev_open: No IRQ for device 3ed40000.vring.
metal: info:      metal_uio_dev_open: No IRQ for device 3ed80000.shm.
echo test: sent : 488
 received payload number 471 of size 488
**********************************
 Test Results: Error count = 0
**********************************
Quitting application .. Echo test end
rpmsg_channel_deleted
WARNING rx_vq: freeing non-empty virtqueue
WARNING tx_vq: freeing non-empty virtqueue
root@Xilinx-ZCU102-2016_3:~#
 
# mat_mul-openamp
...
CLIENT> Matrix multiply: sent : 296
CLIENT> Quitting application .. Matrix multiplication end
CLIENT> **********************************
CLIENT>  Test Results: Error count = 0
CLIENT> **********************************
CLIENT> rpmsg_channel_deleted
WARNING rx_vq: freeing non-empty virtqueue
WARNING tx_vq: freeing non-empty virtqueue
root@Xilinx-ZCU102-2016_3:~#
 
# proxy_app-openamp
login[1900]: root login on 'ttyPS0'
root@Xilinx-ZCU102-2016_3:~# proxy_app-openamp
...
Master> Remote proc resource initialized.
Master> RPMSG channel has created.
Remote>FreeRTOS Remote Procedure Call (RPC) Demonstration
Remote>***************************************************
Remote>Rpmsg based retargetting to proxy initialized..
Remote>FileIO demo ..
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Remote>Creating a file on master and writing to it..
… …
Remote>Repeat demo ? (enter yes or no)
no
Remote>RPC retargetting quitting ...
Remote> Firmware's rpmsg-openamp-demo-channel going down!
Master>
RPC service exiting !!
Master> sending shutdown signal.
WARNING rx_vq: freeing non-empty virtqueue
WARNING tx_vq: freeing non-empty virtqueue
root@Xilinx-ZCU102-2016_3:~#
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Chapter 5

Remoteproc Development

Introduction
The remoteproc APIs provided by the OpenAMP framework allows software applications 
on the master to manage the remote processor and its relevant software. 

This chapter introduces the remoteproc implementation in the OpenAMP library, and 
provides a brief overview of the remoteproc APIs and workflow. 

remoteproc API Functions

remoteproc_resource_init

Description

Initializes resources for remoteproc remote configuration. Only remoteproc remote 
applications are allowed to call this function. This API is called when the remote application 
is running on the remote processor to create the virtIO/RPMsg devices which are used 
for IPC. This API causes remoteproc to use the RPMsg name service to announce the RPMsg 
channels served by the remote application.

Usage

int remoteproc_resource_init( struct rsc_table_info *rsc_info,
                           struct hil_proc *proc,
                           rpmsg_chnl_cb_t channel_created,
                           rpmsg_chnl_cb_t channel_destroyed,
                           rpmsg_rx_cb_t default_cb,
                           struct remote_proc **rproc_handle,
                           int rpmsg_role); 
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Arguments

Returns

Status of execution.

remoteproc_resource_deinit

Description

Uninitialized resources for remoteproc remote configuration. 

Usage

int remoteproc_resource_deinit(struct remote_proc *rproc);

Arguments

rproc - pointer to remoteproc instance.

Returns

Status of execution. 

rsc_info Pointer to resource table info control block.

proc Pointer to the hil_proc.

channel_created Callback function for channel creation

channel_destroyed Callback function for channel deletion.

rdefault_cb Default callback for channel I/O.

rproc_handle Pointer to new remoteproc instance

rpmsg_role - 1 for rpmsg master, or 0 for rpmsg slave
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Chapter 5: Remoteproc Development
remoteproc_shutdown

Description

This function shutdowns the remote execution context.

Usage

int remoteproc_shutdown(struct remote_proc *rproc);

Arguments

rproc - pointer to remoteproc instance to shutdown.

Returns

Status of function execution.
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Chapter 6

RPMsg Development

Introduction 
The RPMsg APIs provided by the OpenAMP framework allow bare-metal or RTOS 
applications to perform inter-process interrupts (IPI) in an AMP configuration, running on 
either a master or remote processor. This information is based on the documentation 
available in the rpmsg.h header file.

This chapter introduces the RPMsg implementation in the OpenAMP library, and provides a 
brief overview of the RPMsg APIs and workflow. 

RPMsg API Functions

rpmsg_sendto

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using the source address of the rpdev. 

If there are no TX buffers available, the function remains blocked until one becomes 
available, or a time-out of 15 seconds elapses. When the latter occurs, ERESTARTSYS is 
returned. This API can be called from process context only. 

Usage

static inline int rpmsg_sendto ( struct rpmsg_channel *rpdev,
void *data, int len, unsigned long dst)
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Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpmsg_send

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using the source and destination address 
of the rpdev. If there are no Tx buffers available, the function remains blocked until one 
becomes available, or a time-out of 15 seconds elapses. When the latter occurs, 
ERESTARTSYS is returned. Presently, this API can be called from process context only. 

Usage

static inline int rpmsg_send(struct rpmsg_channel *rpdev, void *data, int len)

Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpdev The RPMsg channel

data Payload of message

len Length of payload

dst Destination address

rpdev The rpmsg channel

data Payload of message

len Length of payload
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rpmsg_send_offchannel

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using src as the source address. If there 
are no TX buffers available, the function remains blocked until one becomes available, or a 
time-out of 15 seconds elapses. When the latter occurs, ERESTARTSYS is returned. This API 
can be called from process context only.

Usage

static inline int rpmsg_send_offchannel(struct rpmsg_channel *rpdev,
uint32_t, uint32_t dst,
void *data, int len)

Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpmsg_trysend

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using the source of the rpdev and 
destination addresses. If there are no Tx buffers available, the function immediately returns 
ENOMEM without waiting until one becomes available. This API can be called from process 
context only. 

Usage

static inline int rpmsg_trysend(struct rpmsg_channel *rpdev, void *data, int len)

rpdev The rpmsg channel.

src Source address.

dst Destination address.

data Payload of message.

len Length of payload.
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Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpmsg_trysendto

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using the source addresses of the rpdev. 
If there are no TX buffers available, the function immediately returns ENOMEM without 
waiting until one becomes available. This API can be called from the process context only.

Usage

static inline int rpmsg_trysendto(struct rpmsg_channel *rpdev,
void *data, int len, uint32_t dst)

Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpmsg_trysend_offchannel

Description

Sends a message containing data and payload length to the destination address of the 
remote processor respective to the rpdev channel using src as the source address. If there 
are no Tx buffers available, the function immediately returns ENOMEM without waiting until 
one becomes available. This API can be called from process context only.

rpdev The rpmsg channel

data Payload of message

len Length of payload

rpdev The rpmsg channel

data Payload of message

len Length of payload

dst Destination address
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Usage

static inline int rpmsg_trysend_offchannel (struct rpmsg_channel *rpdev,
uint32_t src,
uint32_t long dst,
void *data, int len)

Arguments

Returns

Returns 0 on success, and an appropriate error value upon failure.

rpmsg_init

Description

Allocates and initializes the rpmsg driver resources for a given device ID (cpu_id). The 
successful return from this function enables the IPC link.

Usage

int rpmsg_init( struct hil_proc *proc, struct remote_device **rdev,
rpmsg_chnl_cb_t channel_created,
rpmsg_chnl_cb_t channel_destroyed,
rpmsg_rx_cb_t default_cb, int role);

Arguments

rpdev The RPMsg channel.

src Source address.

dst Destination address.

data Payload of message.

len Length of payload.

param proc The pointer to hil_proc.

@param rdev Source address.

@param channel_created Destination address.

@param channel_destroyed Callback function for channel deletion.

@default_cb Payload of message.

@param role Length of payload.
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Returns

Status of function execution.

rpmsg_deinit

Description

Releases the rpmsg driver resources for a given remote instance.

Usage

void rpmsg_deinit(struct remote_device *rdev);

Arguments

rdev: Pointer to device de-initialize. 

Returns

None.

rpmsg_get_buffer_size

Description

Returns buffer size available for sending messages.

Usage

int rpmsg_get_buffer_size(struct rpmsg_channel *rp_chnl)

Arguments

Channel: Pointer to the rpmsg channel or device.

Returns

Buffer size.

rpmsg_create_channel

Description

Creates rpmsg channel with the given name for remote device.
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Appendix A

Configuration Parameters

Introduction
This appendix lists the verified configuration parameters.

• Zynq-A9 :

Cortex™-A9 #0 running Linux and Cortex-A9 #1 remote running demo applications on 
Standalone or FreeRTOS.

• ZynqMP:

Cortex-A53s running Linux and Cortex-R5s as remote(s) running demo applications on 
Standalone or FreeRTOS in one of the following configurations:

a. Cortex-R5 in lockstep mode. 

b. Cortex-R5 in split mode with either:

- Cortex-R5 #0 remote and Cortex-R5 #1 not running

- Cortex-R5 #1 remote and Cortex-R5 #0 not running

- Cortex-R5 #0 and Cortex-R5 #1 as remotes running concurrently and independently, 
each with its own channel to separate applications on A53. 

The following parameters are the ones you need to inspect and/or modify for your design. Check 
the Wiki: OpenAMP [Ref 1] where more detailed information is provided.

DTS configuration for OpenAMP

File location

<petalinux project directory> project-spec/meta-user/recipes-bsp/device-tree/
files/openamp-overlay.dtsi

General Information

General information on DTS file format can be found by searching online for the 
specification.
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Configuration Parameters for Zynq UltraScale+ MPSoC Devices using 
Cortex-R5

The reserved-memory section below defines which part of the memory visible to 
Cortex-A53 can be reserved for Cortex-R5 firmware use. The current address below points 
to DDR location.

The power-domains section below defines power control capability for individual 
component used by zynqmp_r5_rproc.

The zynqmp_r5_rproc section defines: 

• reg and reg-names: Provide a map of where the registers for the inter-processor 
interrupts (IPI), (RPU), and (ABP) blocks are located in the chip. For example, the IPI 
registers below are located starting at address 0xff340000. For more information on 
registers definition and addresses, see the Zynq UltraScale+ MPSoC Technical Reference 
Manual (UG1085) [Ref 2].

• interrupts : interrupt number used by OpenAMP. The interrupts are the IPI 
interrupts which are used for RPMsg communication. If you use remoteproc to load 
the firmware only, but not use it for communication, you still need to put the IPI 
interrupts in the device tree because it is required by the remoteproc driver.

• core_conf: Provides the mode of operation for Cortex-R5. Values are:

° split0=cortex-R5 #0 

° split1=cortex-R5 #1  

° lockstep 

• Memory resources corresponding to the memory space occupied by the RPU firmware 
when loaded by remoteproc and normally corresponding to its linker script setting:

° r5_0_tcm_a

° r5_0_tcm_b

° elf_ddr0

Code Example

/ {
reserved-memory {
#address-cells = <2>;
#size-cells = <2>;
ranges;
/* Reserved DDR memory for RPU firmware and shared memory (vrings and RPMsg 

buffers between APU and RPU */
rproc_0_reserved: rproc@3ed000000 {
no-map;
reg = <0x0 0x3ed00000 0x0 0x1000000>;

};  
};  
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power-domains {
pd_r5_0: pd_r5_0 {
#power-domain-cells = <0x0>;
pd-id = <0x7>;

};  
pd_tcm_0_a: pd_tcm_0_a {
#power-domain-cells = <0x0>;
pd-id = <0xf>;

};  
pd_tcm_0_b: pd_tcm_0_b {
#power-domain-cells = <0x0>;
pd-id = <0x10>;

};  
};  

amba {
r5_0_tcm_a: tcm@ffe00000 {
compatible = "mmio-sram";
reg = <0x0 0xFFE00000 0x0 0x10000>;
pd-handle = <&pd_tcm_0_a>;

};  
r5_0_tcm_b: tcm@ffe20000 {
compatible = "mmio-sram";
reg = <0x0 0xFFE20000 0x0 0x10000>;
pd-handle = <&pd_tcm_0_b>;

};  

elf_ddr_0: ddr@3ed00000 {
compatible = "mmio-sram";
reg = <0x0 0x3ed00000 0x0 0x40000>;

};  

test_r50: zynqmp_r5_rproc@0 {
compatible = "xlnx,zynqmp-r5-remoteproc-1.0";
reg = <0x0 0xff9a0100 0x0 0x100>, <0x0 0xff340000 0x0 0x100>, <0x0 0xff9a0000 0x0 0x100>;
reg-names = "rpu_base", "ipi", "rpu_glbl_base";
dma-ranges;
core_conf = "split0";
sram_0 = <&r5_0_tcm_a>;
sram_1 = <&r5_0_tcm_b>;
sram_2 = <&elf_ddr_0>;
pd-handle = <&pd_r5_0>;
interrupt-parent = <&gic>;
interrupts = <0 29 4>;

} ; 
};  

};

Configuration Parameters for Zynq-7000 AP SoC Devices using Cortex-A9

• reg: memory range and size used by the firmware.

• vring0 and vring1: two separate interrupts used for signaling between the CPU 
cores.
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Appendix A: Configuration Parameters
Code Example

/ {
amba {
elf_ddr_0: ddr@0 {
compatible = "mmio-sram";
reg = <0x100000 0x100000>;

};  

};  

remoteproc0: remoteproc@0 {
compatible = "xlnx,zynq_remoteproc";
firmware = "firmware";
vring0 = <15>;
vring1 = <14>;
sram_0 = <&elf_ddr_0>;

};  
};

Linux RPMsg Buffer Size
The OpenAMP message size is limited by the buffer size defined in the rpmsg kernel 
module; currently defined as 512 bytes, with 16 bytes for the message header and 496 bytes 
of payload.

While you might be interested in redefining this, resizing the RPMsg size and its effects has 
not been verified. 

In addition to changing the rpmsg kernel module, you would need to change your user 
driver module (for example: the rpmsg_user_dev_driver in the provided examples), as 
well as the OpenAMP library.

Application Resource Table and Linker Script Files 
The demo applications use three files (rsc_table.c, rsc_table.h , and lscript.ld) 
to define the memory usage for OpenAMP. The Zynq UltraScale+ MPSoC Technical Reference 
Manual (UG1085) [Ref 2] provides detailed information on the different type of memory 
accessible.

The resource_table contained in the rsc_table.c file defines the memory regions 
shared between the remote processor and the remoteproc driver running on Linux. This one 
extracts the resource table from the generated ELF file for the remote processor. 

You could, for example, add or remove carveout sections, (RSC_CARVEOUT), defined in 
the Linux Kernel remoteproc documentation as "physically contiguous memory regions." 

You can also modify RSC_RPROC_MEM which lets Linux know about the desired shared 
memory location used to communicate. 
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Appendix A: Configuration Parameters
Note: The RSC_RPROC_MEM address range must be inside the range defined by the DTS 
reserved-memory section for rproc. It should not overlap its address with the ones defined in the 
device tree zynq..._rproc section and which are used to load the firmware.

The lscript.ld is for the linker use, and defines the memory usage for the firmware.

Interrupts

The demo applications use two files (platform_info.c and platform_info.h) to define the 
interprocessor interface (IPI) base addresses and the IPI interrupt vector ID used with OpenAMP. 
For example, when building the demo applications for cortex_r5_1 you set:

• platform_info.c to IPI_BASE_ADDR = 0xFF320000

• platform_info.h to IPI_IRQ_VECT_ID = 66

Compilation Flags
The following parameters can be provided to the toolchain via the extra compiler flags.

You can access the extra_compiler_flag field in the Xilinx® SDK BSP for your application. 

See the SDK Help [Ref 3] for more information. 

For the Zynq®-7000 All Programmable (AP) SoC device (zynq):

a. To disable initialization of shared resources when the master processor is handling 
shared resources initialization, add: 

-DUSE_AMP=1

b. To allow OpenAMP to redirect _open(), _close(), _read(), and _write(), add

-DUNDEFINE_FILE_OPS

This parameter is used when the OpenAMP library is linked with the 
rpmsg_retarget.o file. 

This can be enabled or disabled when creating the application BSP in the Xilinx SDK, 
and setting the WITH_PROXY option in the OpenAMP section to either True or 
False. 

Note: You do not need to set this flag when using Xilinx SDK. It is automatically set when 
changing the WITH_PROXY parameter.
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Appendix A: Configuration Parameters
c. To allow OpenAMP to redirect _open(), _close(), _read(), and _write(), add:

-DUNDEFINE_FILE_OPS.

This parameter is used when the OpenAMP library is linked with the 
rpmsg_retarget.o file. 

This can be enabled or disabled when creating the application BSP in the Xilinx SDK 
and setting the WITH_PROXY option in the OpenAMP section to either True or 
False. 

Note: You do not need to set this flag when using Xilinx SDK. It is automatically set when 
changing the WITH_PROXY parameter.

Changing the RPMsg Channel ID 
Changing the RPMsg ID might be required if you need to create multiple OpenAMP slaves, 
because the messages carry an individual identifier associated to each channel.

To change the RPMsg ID: 

1. Modify the rpmsg_user_dev_driver, LKM, by changing the string ‘.name’ in the 
structure rpmsg_user_dev_drv_id_table, so that it is a unique identifier for this 
channel.

2. Modify user application platform_info.c file by changing the channel name in this 
file. 
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Appendix B

Libmetal Introduction and Libmetal 
Examples

Libmetal Overview
The Libmetal library maintained by the OpenAMP open source community. It provides 
common user APIs to access devices, handle device interrupts, and request memory across 
different operating environments. 

Libmetal supports Zynq®-7000 and Zynq UltraScale+™ MPSoC platforms in the following 
operating systems:

• Linux userspace

• FreeRTOS

• Bare-metal environments

The following architecture diagram shows how OpenAMP uses the libmetal library:

See the libmetal sources [Ref 5] for more details on the libmetal APIs.

X-Ref Target - Figure B-1

Figure B-1: OpenAMP libmetal Architecture
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Libmetal Example
This example shows how to use the libmetal library to build simple inter-processor 
communication between APU and RPU on a Zynq UltraScale+ MPSoC platform. The example 
uses the following resources for the inter-processor communication:

• DDR device memory as shared memory

• IPI (inter-processor interconnect) for notification

This chapter describes how to build the libmetal example with Xilinx® SDK and PetaLinux 
tools.

Note: This example is for Zynq UltraScale+ MPSoC platforms only. It runs on RPU, and it only 
supports bare-metal environments.

Build Libmetal Bare-Metal Firmware with Xilinx 
SDK
1. From the SDK window, create the application project by selecting File > New > 

Application Projects.

a. Specify the BSP OS platform:

- standalone for a bare-metal application.

b. Specify the hardware platform.

c. Select the processor:

- Cortex™-R5 (RPU) is supported. Select psu_cortexr5_0 or psu_cortexr5_1.

d. Select one of the following BSP options:

- Use Existing if you had previously created an application with a BSP and want to 
reuse the same BSP. In this case, you need to make sure that the libmetal 
library is selected in the BSP.

- Use Create New BSP to create a new BSP. If you make this selection, the 
libmetal library is automatically included.

e. Click Next to select an available template. (Do not click Finish.) 

f. From the available templates, select Libmetal Echo Demo.
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Appendix B: Libmetal Introduction and Libmetal Examples
g. Click Finish.

h. Before you build the application, review the source code of the generated 
application from the SDK project explorer. The key source files of the libmetal 
demonstration application are as follows:

- sys_init.c: System initialization, such as GIC initialization, and metal device 
definition for IPI device and shared memory

- libmetal_amp_demo.c: Demo application that illustrates how to use IPI and 
shared memory with libmetal for inter-processor communication.

2. To build the application project, right-click the created project and select Build project. 
The generated ELF is in the <RPU_app_proj>/Debug/ directory.

Enable Linux Demo Application Using Libmetal with 
PetaLinux Tools
Before using PetaLinux tools, follow these preparatory steps:

1. Create the PetaLinux master project in a suitable directory without any spaces. In this 
guide it is named <plnx_proj>: 

$ petalinux-create -t project -s <PATH_TO_PETALINUX_ZYNQMP_PROJECT_BSP>

2. Navigate to the directory: 

$ cd <plnx_proj>

3. Enable the required rootfs packages and applications: 

$ petalinux-config -c rootfs

4. Ensure libmetal and sysfs packages are enabled:

Filesystem Packages--->
misc --->

sysfsutils --->
[*] libsysfs

Libs --->
libmetal--->

[*] libmetal

5. Ensure the libmetal demo application is enabled: 

Filesystem Packages --->
libs --->
libmetal-->
[*] libmetal-demos
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Setting Device Tree for the Libmetal Linux 
Application Demonstration
The libmetal Linux demonstration uses UIO devices for IPI and shared memory. Copy the 
following to your project-spec/meta-user/recipes-bsp/device-tree/files/system-user.dtsi in 
your PetaLinux project and modify as needed.

/ {
        reserved-memory {
                #address-cells = <2>;
                #size-cells = <2>;
                ranges;
                rproc_0_reserved: rproc@3ed000000 {
                        no-map;
                        reg = <0x0 0x3ed00000 0x0 0x1000000>;
                };
        };
        amba {
/* Shared memory descriptor (APU to RPU) */

               shm0_desc: shm_desc@0 {
                        compatible = "shm_desc_uio";
                        reg = <0x0 0x3ed00000 0x0 0x10000>;
                };
/* Shared memory descriptor (RPU to APU) */

                shm1_desc: shm_desc@1 {
                        compatible = "shm_desc_uio";
                        reg = <0x0 0x3ed10000 0x0 0x10000>;
                };
/* Shared memory */

                shm0: shm@0 {
                        compatible = "shm_uio";
                        reg = <0x0 0x3ed20000 0x0 0x40000>;
                };
/* IPI device */

                ipi0: ipi@0 {
                        compatible = "ipi_uio";
                        reg = <0x0 0xff340000 0x0 0x1000>;
                        interrupt-parent = <&gic>;
                        interrupts = <0 29 4>;
                };
        };
};

The source code of the libmetal example on the Linux side can be found on the following 
web sites:

• https://github.com/Xilinx/libmetal/blob/xilinx-v2017.1/examples/system/linux/zynqmp/zynqmp_amp_de
mo/init_linux.c

• https://github.com/Xilinx/libmetal/blob/xilinx-v2017.1/examples/system/linux/zynqmp/zynqmp_amp_de
mo/libmetal_amp_demo.c
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Build the Linux Demo Application and the Linux 
Project
1. Go to the PetaLinux tools project:

$ cd <plnx_proj>

2. Build the PetaLinux project:

$ petalinux-build

The kernel images and the device tree binary are located in the 
<plnx_proj>/images/linux directory.

Testing on Hardware
1. Go to the PetaLinux project:

$ cd <plnx_proj>

2. Build the PetaLinux project:

$ petalinux-build

3. Run PetaLinux boot:

$ petalinux-boot --jtag --kernel

If you encounter any issues, append -v to these commands to see the textual output.

4. Boot the RPU firmware built with Xilinx SDK with the xsdb command:

$ xsdb
xsdb% connect
xsdb% ta 7 # this is the RPU0 target.
                     # you can use "ta" to see all the targets and which you have 
connected to.
xsdb% rst -processor # reset the connected RPU target
xsdb% dow <the RPU libmetal demo ELF image built with Xilinx SDK>
xsdb% con # This will start the RPU

You can also use other methods to boot Linux on APU and the firmware on RPU, such as 
SD boot. This example only documents JTAG boot.
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5. On the APU Linux target console, run the demo application libmetal-demo. This 
process produces output similar to the following:

# libmetal-amp-demo

metal: warning:   skipped page size 2097152 - invalid args
metal: info:      metal_uio_dev_open: No IRQ for device 3ed00000.shm_desc.
metal: SERVER> SENDING message...
SERVER> Wait for echo test to start.
info:      metal_uio_dev_open: No IRQ for device 3ed10000.shm_desc.
metal: info:      metal_uio_dev_open: No IRQ for device 3ed20000.shm.
CLIENT> Start shm atomic testing...
CLIENT> shm atomic testing PASS!
CLIENT> Start echo flood testing....
CLIENT> It sends msgs to the remote.
CLIENT> And then it waits for msgs to echo back and verifiy.
CLIENT> Sending shutdown message...
CLIENT> Total packages: 1024, time_avg = 0s, 7721ns
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Appendix C

Linux Userspace RPMsg Application Flow

Introduction
The OpenAMP library provides RPMsg APIs for applications to use in sending messages to 
and receiving messages from another processor. It also provides a remoteproc driver that 
triggers the inter-processor interrupt (IPI) to notify another processor if there is a message 
that needs to be sent and that monitors the IPI for notifications from another processor. The 
provided demo polls the IPI interrupt status register to see if IPI is triggered by another 
processor. The following is a flow diagram of an RPMsg in Linux Userspace Application. This 
diagram shows the RPMsg application running on APU and talking to the firmware on RPU. 

X-Ref Target - Figure C-1

Figure C-1: RPMsg Flow Diagram in Linux Userspace Application
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Appendix C: Linux Userspace RPMsg Application Flow
Linux Userspace RPMsg Application Platform Data 
Definition
The Linux application is required to define the resource table and the platform information 
data. For examples, you can refer to the rsc_table.c and platform_info.c files in the 
in the OpenAMP source code repository:

• Resource table:
https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/rsc_table.c

• Platform specific data:
https://github.com/Xilinx/open-amp/blob/xilinx-v2017.1/apps/machine/zynqmp/platform_info.c

Resource Table
As shown in the following example, you need to define the vrings address space, which 
contains the shared memory descriptors in the resource table. 

struct remote_resource_table __resource resources = {
/* Version */
1,

/* Number of table entries */
NUM_TABLE_ENTRIES,
/* reserved fields */
{0, 0,},

/* Offsets of rsc entries */
{
 offsetof(struct remote_resource_table, rpmsg_vdev),
 },

    /* Virtio device entry */
{RSC_VDEV, VIRTIO_ID_RPMSG_, 0, RPMSG_IPU_C0_FEATURES, 0, 0, 0,
 NUM_VRINGS, {0, 0},
 },

/* Vring rsc entry - part of vdev rsc entry */
{
 RING_TX, VRING_ALIGN, VRING_SIZE, 1, 0},
{
 RING_RX, VRING_ALIGN, VRING_SIZE, 2, 0},

};
Xilinx OpenAMP Framework 53
UG1186 (v2017.1) May 3, 2017 www.xilinx.com

Send Feedback
UG1186 (v2017.2) June 29, 2017

https://www.xilinx.com
https://github.com/Xilinx/open-amp/blob/xilinx-v2017.2/apps/machine/zynqmp/platform_info.c
https://github.com/Xilinx/open-amp/blob/xilinx-v2017.2/apps/machine/zynqmp/rsc_table.c
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1186&Title=OpenAMP%20Framework%20for%20Zynq%20Devices%3A%20Getting%20Started%20Guide&releaseVersion=2017.2&docPage=53


Appendix C: Linux Userspace RPMsg Application Flow
Platform Data
You need to specify the IPI device, vring device, and shared memory device in the platform 
data definition. 

Each device should have a device node defined in the device tree. 

What you need to define depends on the remoteproc driver in the OpenAMP library. 

The following example is based on the RPMsg remoteproc Linux Userspace driver for 
Zynq® UltraScale+™ MPSoC platform.

struct hil_proc *platform_create_proc(int proc_index)
{
(void) proc_index;
struct hil_proc *proc;
proc = hil_create_proc(&zynqmp_a53_r5_proc_ops, RPU_CPU_ID, NULL);
if (!proc)
return NULL;

/* Setup vring info */
hil_set_vdev(proc, NULL, NULL);
/* Setup IPI info */
hil_set_vdev_ipi(proc, 0,
(unsigned int)(-1), (void *)&chn_ipi_info[0]);

hil_set_vring_ipi(proc, 0,
(unsigned int)(-1), (void *)&chn_ipi_info[0]);

hil_set_vring_ipi(proc, 1,
(unsigned int)(-1), (void *)&chn_ipi_info[0]);

/* Setup vring info */
hil_set_vring(proc, 0, DEV_BUS_NAME, VRING_DEV_NAME);
hil_set_vring(proc, 1, DEV_BUS_NAME, VRING_DEV_NAME);
/* Setup shared memory info */
hil_set_shm (proc, DEV_BUS_NAME, SHM_DEV_NAME, 0, 0x40000);
/* Setup RPMSG channel info */
hil_set_rpmsg_channel(proc, 0, RPMSG_CHAN_NAME);
return proc;

}
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Appendix D

Additional Resources and Legal Notices

Xilinx Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx 
Support.

Solution Centers
See the Xilinx Solution Centers for support on devices, software tools, and intellectual 
property at all stages of the design cycle. Topics include design assistance, advisories, and 
troubleshooting tips.

Documentation Navigator and Design Hubs
Xilinx® Documentation Navigator provides access to Xilinx documents, videos, and support 
resources, which you can filter and search to find information. To open the Xilinx 
Documentation Navigator (DocNav):

• From the Vivado IDE, select Help > Documentation and Tutorials.

• On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

• At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other 
topics, which you can use to learn key concepts and address frequently asked questions. To 
access the Design Hubs:

• In the Xilinx Documentation Navigator, click the Design Hubs View tab.

• On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page 
on the Xilinx website.
Xilinx OpenAMP Framework 55
UG1186 (v2017.1) May 3, 2017 www.xilinx.com

Send Feedback
UG1186 (v2017.2) June 29, 2017

https://www.xilinx.com
https://www.xilinx.com/support/solcenters.htm
https://www.xilinx.com/support
https://www.xilinx.com/support
https://www.xilinx.com/cgi-bin/docs/ndoc?t=design+hubs
https://www.xilinx.com/cgi-bin/docs/rdoc?t=docnav
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1186&Title=OpenAMP%20Framework%20for%20Zynq%20Devices%3A%20Getting%20Started%20Guide&releaseVersion=2017.2&docPage=55


Appendix D: Additional Resources and Legal Notices
Xilinx Documentation
1. OpenAMP Wiki: http://www.wiki.xilinx.com/OpenAMP

2. Zynq UltraScale+ MPSoC Technical Reference Manual (UG1085)

3. Xilinx Software Developer Kit Help (UG782)

4. PetaLinux Tools Documentation: Reference Guide (UG1144) 

5. Xilinx libmetal source code: https://github.com/Xilinx/libmetal

6. Xilinx OpenAMP source code: https://github.com/Xilinx/open-amp

Please Read: Important Legal Notices
The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the 
maximum extent permitted by applicable law: (1) Materials are made available “AS IS” and with all faults, Xilinx hereby DISCLAIMS 
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MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether 
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related 
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, 
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a 
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised 
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of 
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials 
without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to 
Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support 
terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any 
application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, 
please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.
This document contains preliminary information and is subject to change without notice. Information provided herein relates to 
products and/or services not yet available for sale, and provided solely for information purposes and are not intended, or to be 
construed, as an offer for sale or an attempted commercialization of the products and/or services referred to herein.
Automotive Applications Disclaimer
AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF 
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A 
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY 
DESIGN”).  CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY 
TEST SUCH SYSTEMS FOR SAFETY PURPOSES.  USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS 
FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON 
PRODUCT LIABILITY.
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